
Build a map from Flags
Magellan and Captain Cook did an excellent job of charting the world. But despite 
what some people might think, there is still a place for cartographers and mapmakers
in the 21st century. Cartography and map-making might seem methodical, technical 
and bland. But within the discipline exists much room for artistry, originality, and 
thinking outside the box. In this tutorial, you can tell a captivating story by 
combining a simple map, a splash of color, and a little ingenuity. 

You will create a flag map of Canadian provinces and territories, inspired by this 
map: Map: The biggest company in every state. 

Figure 1. The final product, in all its glory. 

You will take advantage of two free, open-source tools to complete this project. To 
create the map, you will use a GIS tool called QGIS. To edit the image, you will use 
the image editing program known as GIMP. Before you begin, you must first 
download and install these tools on your machine. 

Download and Install QGIS
For the purpose of this analysis, you will use QGIS, which is a free, open source tool 
you can download and install on your computer from the following website:

https://www.qgis.org/en/site/forusers/download.html

https://www.qgis.org/en/site/forusers/download.html
https://www.washingtonpost.com/news/wonk/wp/2015/06/21/map-the-biggest-company-in-every-state/?noredirect=on&utm_term=.87328f869812
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Figure 2. The QGIS download page.

Windows users will be asked to choose between the 32-bit and 64-bit version. Most 
users with a newer computer will want to choose the 64-bit option. After the 
download is complete, navigate to the download location and double click on the 
setup.exe (if using Windows OS).The installer will take you through the installation 
process step-by-step. Unless you are a power user, accepting the installer’s defaults is
recommended. 

Download and Install GIMP
To edit the map and manipulate the flag images, you will use GIMP, a well-known, 
open source image editing program. Download it here: GIMP download. 

On the download page, you will be given two options: 
1. Download via BitTorrent
2. Download via a direct link
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Figure 3. The GIMP download page. 

If you have BitTorrent installed on your computer, you can choose the first option. 
For most people, the second option (direct download) is more straightforward. 

As you can see in the screenshot above, GIMP  recommends a download for your 
computer’s operating system. If the recommendation is incorrect, links to other 
operating system downloads are also shown. Once you click on the direct download 
link, the download begins and will take several minutes. Once the download is 
complete, navigate to the download location and double click on the setup.exe (if 
using Windows OS). The installer will take you through the installation process step-
by-step. Unless you are a power user, accepting the installer’s defaults is 
recommended. 

Download the Flag Images
The flags for Canada’s 10 provinces and 3 territories can be downloaded here:

Canada Provincial Flags

When you save the flags, create a folder where you can save all files and images 
related to this project. Keeping all files in one folder will make it easier to keep track 
of all your data. 

Use the Shapefile to Create the Map in QGIS
After you have the required software, your first task is to create the map. If you have 
never used GIS software, this may seem daunting at first. However, creating the map 
you will use for this project is actually simple. Many free spatial layers are available 
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https://drive.google.com/drive/folders/1YHzt0DCBmXjAKkF98TwTXA70vBjB4SSy?usp=sharing
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for download. These spatial layers can be opened and manipulated using software, 
such as QGIS. To download the boundaries of the Canadian provinces 
and territories you will for this project, follow this link: Statistics Canada GIS data.
 

1. Under “Boundary File Options, select English as the language (or French, if 
you prefer).

2. Select “ArcGIS  (.shp). The shapefile (.shp) format is widely used and is recognized Ⓡ
by most GIS tools. 

3. Select “Provinces/territories” from the Cartographic Boundary File column.
4. Select “Continue”.
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https://www12.statcan.gc.ca/census-recensement/2011/geo/bound-limit/bound-limit-2011-eng.cfm
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Figure 4. The Canada boundary shapefile download page.

On the next screen, there is  a link to a .zip file (gpr_000b11a_e.zip). In Windows, 
right click on this link and save it to the location where you are 

5



Canada Flag Map Tutorial

Keeping files for this project.

Figure 5. The Canada boundary shapefile download file.

Navigate to the folder where you saved this file. Right click on the file and extract the 
data using your zip tool of choice. A shapefile is comprised of multiple files, as shown
below: 

Figure 6. Shapefiles are comprised of multiple files that act as one. 

Now that you have your Canadian boundary data, you will create an image showing 
the boundaries of Canada’s 10 provinces and 3 territories. 

1. Open QGIS
2. From the Layer Menu at the top, select “Add Layer”

Figure 7. Add your Canada boundary shapefile to a QGIS project. 
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3. Select “Add Vector Layer” 
4. A “Data Source Manager” dialog Box will open. 

a. Next to the Vector Dataset(s) field, click the “Open OGR Supported 
Vector Formats” button shown below.

Figure 8. QGIS Data Source Manager.

b. In the resulting dialog box, navigate to the folder where you saved the 
shapefile.

c. Click on the file with the .shp extension (gpr_000b11a_e.shp).
d. Select “Open”.
e. You will return to the Open OGR Supported Vector Formats dialog box.

Click Add.

Figure 9. Add the file to the project and close the dialog box.

f. Click Close.

The boundary data for Canada appears as below. QGIS randomly assigns a color to 
the provinces and territories, so the color you see might be different. 
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Figure 10. The shapefile showing Canada’s ten provinces and three territories.

After a few adjustments, you will be ready to export the map and then edit it using 
GIMP.

Enable the QGIS Processing Toolbar
A good way to make it easier to find tools within QGIS is to use the Processing 
Toolbar, which allows you to search for what you are looking for rather than wasting 
precious time perusing the menus one-by-one. 

To access the Processing Toolbar, complete the following steps: 
1. Click on the Processing menu. 

Figure 11. How to add the Processing Toolbar to your QGIS project.
2. Select Toolbox.
3. Notice the Processing Toolbar appear on the right side of the screen. 
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Fix the Geometry
Despite the best efforts and quality assurance measures, data are rarely perfect. This 
is true for the data you downloaded from Statistics Canada. In order to avoid errors 
later on, you should use QGIS’s Fix Geometry tool. Geomtry errors might cause 
future processes to run incorrectly or fail altogether. Just because you have obtained 
data from a reputable source doesn't mean the data are without problems. The Fix 
Geometry tool will take care of data problems before they  become an issue for you.

1. In the textbox of the Processing Toolbar, type fix or repair.

Figure 12. Run the fix geometries tool from the Processing Toolbar

2. From the Vector geometry toolkit, double click “Fix geometries”.
3. If it is not already selected, make gpr_00b11a_e the Input layer.
4. Under Fixed geometries, click the Fixed geometries button, which looks like 

this: 
a. From the menu that pops up, select Save to File…

Figure 13. Save to file.

b. The Save file dialog box opens.
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Figure 14. How to save the map layer with fixed geometry.

a.i.  Navigate to the folder where you saved your Canada province/territory
shapefile. 

a.ii.  Choose a name for your repaired shapefile. For this tutorial, 
canadaProvinces_repair was used. 

a.iii. The default file type in QGIS is known as a GPKG file. Use the default 
GPKG or select SHP files from the Save as type.

a.iv.  Click Save.

5. Back on the Fix Geometries dialog box, click Run in Background. The Fix 
Geometries tool will take several minutes to run. When the Processing 
algorithm status bar reaches 100%, the file you repaired will be added to the 
Layers window on the left side of the QGIS user interface. 

6. Click Close.

Change the Projection
As it stands, your map of Canada is starting to takes shape. To improve the look of 
this map,change the map projection. Projections are a very important topic within 
GIS but can be confusing to new GIS users. Converting a 3-dimensional object (the 
Earth) to a 2-dimensional surface (a map) creates distortion. Maps can be distorted 
in a variety of ways (shape, area, direction, distance). The larger the area the map 
represents, the larger the distortion. For the purposes of this tutorial, high precision 
and accuracy aren’t needed. It may seem shallow, but for the purposes of this 
tutorial, you are only concerned with looks. Therefore,use the projection 
recommended by Statistics Canada: Lambert conformal conic projection. 

1. In the Processing Toolbar, type the term “project”, then press enter.
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Figure 15. Reproject your map.

2. From the Vector general toolkit, double click “Reproject layer”.
3. The Reproject layer dialog box will open. The layer you want to use is the 

Fixed geometries layer you created in the previous section. 

4. Click the Select CRS button, which looks like this: . The Coordinate 
Reference System Selector opens.
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Figure 16. Coordinate Reference System Selector.

a. Type “Lambert Conformal” in the Filter textbox and press Enter.
b. In the Coordinate reference systems of the world window, click on 

North_America_Lambert_Conformal_Conic.
c. Click OK.

5. Click Run in Background. When the Processing algorithm status bar reaches 
100%, the projected file is added to the Layers window on the left side of the 
QGIS user interface

6. Click Close. 

Change Symbology
The colors and shapes you use to represent features on a map are known collectively 
as symbology. In order to make it easier to edit the image later,   change the current 
symbology and assign a unique color to each province/territory.

1. In the Layers panel on the left side of the QGIS window, right click the 
Reprojected layer you created in the previous step.

Figure 17. Assign unique (categorized) colors to each province/territory.

2. Click Properties.
3. The Layer Properties dialog box opens. Click on the Symbology tab.
4. At the top next to the field currently containing Single symbol, click the down 

arrow ( ).
5. From the resulting dropdown box, click on Categorized. 
6. The Layer Properties window updates to give you new options for the 

Categorized option. From the Column dropdown menu, select PRENAME. 
PRENAME is the field that contains the name of each province/territory, 
which allows you to represent the data in an intuitive way.
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Figure 18. Use a categorized color ramp to assign colors.

7. From the Color ramp drop down menu, select Random colors (if not already 
selected).

8. Click Classify. New symbols with unique colors for each province/territory  
populate the Layer Properties window. 

9. Click OK. 

The colors may be different, but your map will look something like this:

Figure 19. The result of changing your map’s symbology. 
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Zoom to the Image
Before exporting the image as a .png file, make sure that the map is centered in the 
main QGIS window. To do this, right-click the Reprojected layer in the Layer window
on the left side of the QGIS user interface. In the resulting menu, click Zoom to 
Layer.

Figure 20. Zoom to Layer.

Export the image as PNG image file
Now that you have centered your image, export your image to an file that will be 
edited in GIMP.

1. Right click the Reprojected layer in the Layers window.
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Figure 21. Export the map as an PNG image.

2. In the resulting menu, click Import/Export.
3. Select Export Map to Image.
4. In the Resolution box, use the arrow to adjust the resolution for the exported 

photo. A value of at least 200 dpi is recommended.
5. Click Save.
6. The Save dialog box will open. Navigate to the folder where you are saving 

files for this project.

Figure 22. The Save dialog box.

7. Give the file a name that you can easily remember. In this example, 
canadaProvinceMap is used. 

8. Click Save.

The image of your map  saves to the folder you indicated. You can now close QGIS 
and open GIMP to begin editing the map. 

Open the Map Image
After GIMP opens, open the Canadian province map image that you previously 
created in QGIS.

1. From the File menu, click Open.
2. In the resulting Open Image dialog box, navigate to the folder where you 

saved canadaProvinceMap.png (or whatever you named the file) and select 
that file.

3. Click Open.
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Figure 23. Open an image in GIMP.

Saving
GIMP’s default file format has a .xcf extension. Save your project as an XCF file 
(File...Save) to the same folder you saved your map and flag images. If you want to 
save your image to a different image format that can be viewed or edited in other 
image software tools (such as JPG or PNG), use the Export As function instead 
(File...Export As). 

Zooming
As you work with GIMP, you may need to zoom in for a closer look and zoom out 
again for a wider view. To zoom in towards a certain feature, hover over that feature 
with your mouse pointer and then press the Shift key and the + (plus) key in tandem 
over and over until you have zoomed in a far as you want. To zoom out, press the - 
(minus) key as many times as necessary. If you have zoomed in too far, or have lost 
track of where you are during the zoom process: 

1. From the View menu, select Zoom.
2. From the Zoom submenu, select Fit Image in Window.
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Figure 24. Zoom to the extent of your image.

Layers
Throughout the remainder of this tutorial, you will be working with layers. GIMP 
allows you work with multiple layers that will ultimately comprise a single image 
when all is said and done. Your main layer is the map of Canadian provinces and a 
series of sublayers represent the flags of the various provinces and territories. You 
retain those portions of the flag sublayers that are within the boundary of the 
corresponding province or territory and deleting the remainder. 

To get the effect you want, make sure that transparency is enabled within the image. 
If the background is transparent, parts of the image that you delete will be invisible 
rather than showing up as white, black or another color.

1. In the Layers window shown in the bottom right, right-click the layer of the 
province or territory that you wish to check for transparency.

Figure 25. Add transparency to each layer.
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2. In the resulting menu, click Add Alpha Channel. If the Add Alpha Channel 
command is grayed-out, transparency is already enabled.

Select by Color
To make your flag map, work your way around the country, one province or territory 
at a time. Select the province/territory, add the corresponding flag as a new layer, 
trim the flag to fit the geographic boundaries, and delete the part of the flag image 
that is outside those boundaries. 

Some of Canada’s provinces and territories have many islands in addition to the 
main landmass. Selecting every single piece of every province is too time-consuming 
to be practical. Thankfully, GIMP has a tool that allows you to select by color. Since 
each province/territory has a different color, you can easily select every piece with 
one click. 

To begin, click the Select by Color Tool as shown below: 

Figure 26. Use the Select by Color tool to select each province individually

Canada has three large territories that make up the northern half of the country 
(represented on the map above as Nunavut in purple, the Northwest Territories in 
light blue, and the Yukon territory in orange--note: the colors assigned to each 
province by QGIS may be different on your map). With the Select by Color Tool 
selected, click on Nunavut. The entire territory is now highlighted. 

As you add the flag for each province/territory, be sure that the area you are working 

on remains selected. If you use one of the various select tools ( ) 
and click outside the area that is currently selected, another area will be selected 
instead. Ctrl + Z will undo the previous action(s) and can be a lifesaver in these 
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situations. In the event it is too late to use Ctrl + Z (such as when you reopen the 
image after saving and closing the program), check the appendix for several ideas for 
how to get back on track. 

Open Flag Image as a Sublayer
The next step is to add the flag to the map that corresponds to the province/territory 
you are working on. Then clip the flag based on those boundaries and  delete those 
parts of the flag that fall outside the boundary. It is best to go through the entire 
process for each province one-by-one rather than adding all the flag images at once. 

To begin, add the flag image for Nunvaut (whose boundaries  you selected on the 
map in the previous step):

1. From the File menu, select Open as Layers.

Figure 27. Open the Nunavut layer.

2. Navigate to the folder where you saved your flag images and click on 
nunavut.png.

3. Click Open.

Rearrange Layers to Change Their Position
The image of Nunavut’s flag appears on top of the Canada boundary map. Ultimately 
you want all the flag sublayers to reside underneath the boundary map, not on top. 
Consequently, you need to rearrange the layers. 

1. In the Layers window in the bottom right corner of the GIMP user interface, 
click and hold down nunavut.png. 
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Figure 28. Move layers up and down.

2. While holding down the left mouse button, drag nunavut.png below the 
canadaProvincesMap layer. Notice the white line that appears below the 
canadaProvincesLayer.

3. Let go of the left-mouse button. Nunavut.png should appear underneath 
canadaProvincesMap, as shown above. 

Delete the Selected Area from the Canada Map
The color for each province/territory simply makes it easier to select each province. 
Now that you have selected the territory of Nunavut you want to replace the current 
color with the flag of Nunavut. Making sure that the map of Canada is selected in the 
Layers window on the right side, hit delete on your keyboard. The color that 
represented Nunavut disappears and is replaced by a transparent background in 
GIMP represented as a checkerboard of dark gray and light gray squares. 

Resize the Province/Territory
In order for the flag to fit best within the boundaries, you need to resize the flag 
image. You need to make a judgment on a province-by-province basis, but most 
Canadian provinces and territories stretch farther from north to south than east to 
west. Therefore, you want the the length of the flag image to be equal to or slightly 
greater than the length of the province from north to south measured in pixels on the
map. To do this, use the measure tool:

1. Select the Measure tool from the toolbox on the left side of the GIMP user 
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interface ( ).
2. Using Nunavut as an example, left-click just to the north of the territory’s 

northernmost point, as shown below.

Figure 29. How to use the measure tool.

3. While continuing to hold down the left mouse button, move the mouse to a 
point straight below the first point and just below the southernmost boundary 
of Nunavut.

4. Release the left mouse button.

5. The length in pixels will be listed at the bottom ( )

Repeat this for each province’s flag sublayer. Once you know the greatest extent, you 
can now resize the flag to its best fit. 

1. Right click on nunavut.png in the layer window in the bottom right corner.
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Figure 30. Resize a sublayer.

2. In the resulting menu, select Scale Layer.
3. A Scale Layer dialog box opens. In the Height box, type the pixel value you 

obtained by using the Measure tool (in this case, 895 pixels). 
4. Click Scale.

Move the Flag into Place
Now that the flag image is the correct size, you need to move it so that it completely 
fills the territorial boundaries. Positioning the map within the province/territory is 
more of an art than a science, so its' up to you decide what looks best. It is important,
though, that all of the transparent areas (represented by the gray checkerboard 

pattern-- ) are covered by the flag image. 
1. Select the Move tool from the toolbox on the left side of the GIMP user 

interface ( ).
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Figure 31. Moving layers using the Move tool.

2. Make sure that the Nunavut flag layer is highlighted in the layer box at the top 
right (note: highlighted layers are shown in a darker shade of gray than the 
unselected layer). 

3. Click on the object you want to move, in this case the flag of Nunavut. A small 
cross marks the point where you click. This cross follows your mouse as you 

move it across the screen ( ). Continue to hold onto the left mouse button 
until you have placed the flag in a position that entirely fills the boundaries. 
Now release the mouse.

If you accidentally click another layer, the clicked layer will be the one that moves. In 
that case, undo the action using Ctrl + Z. You can move the image again until it 
appears where you want. 

Delete the Parts of the Flag Image that Fall Outside the Boundaries
It might not seem like a problem when importing the first flag into the map, but as 
you delete the fill and add the flag image for other provinces/territories, you will start
to have a mess on your hands. The previous province/territory’s flag will encroach 
upon the boundaries of the province or territory you work on next. To avoid this 
situation, you want to delete those parts of the flag that fall outside the 
corresponding province/territory’s boundaries. 

The first step is to create a path, which acts like a cookie cutter. Retain the portion of 
the flag you want and dispose of the rest.

Before you begin, make sure that Nunavut’s boundaries are still selected in the main 
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window and that the Canada Provinces Map is selected in the Layer window.
1. In the main window in the center of the GIMP user interface, click the right 

mouse button.

Figure 32. Use the select path tool.

2. In the resulting menu, click Select. 
3. The Select Menu will open. Click the To Path tool.

In the Layers window, temporarily make canadaProvincesMap invisible by clicking 

the eye icon ( ) to the left of the layer name. Now, you see only the Nunavut flag 
image. You can see in the image below, that the To Path tool created a cookie cutter 
from Nunavut’s geographic boundaries. Before you delete the portion of the Nunavut
flag that lies outside the territory’s boundaries, you need to invert the selection. 
Otherwise, you will delete the part you want to keep. 

To invert the selection, make sure that nunavut.png is highlighted in dark gray in the 
Layers window. This is important since the layer that is selected will be affected by 
the following command. Now, simply hold down Ctrl + I or go to the Select Menu 
and click Invert. 
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Figure 33. Invert the selection.

Now, click the Delete key on your computer. The portion of the flag that lies within 
Nunavut is the only thing that remains (see below). 

Figure 34. Nunavut’s flag clipped to the territorial boundaries.

Now you want to turn on the canadaProvinceMap layer again. In the blank area to 
the left of the canadaProvincesMap (underneath the word Lock in the Layers 

window), click once and the eye icon ( ) reappears,similar to this:
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Figure 35 . Nunavut boundaries and flag merged into a single entity.

It is wise to lock the clipped flag into place so that you do not accidentally move it 
when you are working on another area. With nunavut.png selected in the Layers 

window, click the Lock button ( ). 

Figure 36. Lock the flag image in place.
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To avoid confusion, it is also a good idea to turn off the visibility of nunavut.png 
before you move on to the next province/territory. 

You will repeat this same process for the other two territories and ten provinces. 
If your Canadian geography is rusty, refer to the map here:

Political map of Canada

Final Touches
Now that you have added, moved and clipped all of the flags to your map, you want 
to merge all of your layers into a single image. If you export the image as a PNG, JPG 
or other image file, the multiple layers merge into a single image, with no special 
steps required. 

1. From the File menu, select Export As. Alternatively, you can hold down 
Shift+Ctrl+E.

Figure 37. How to export your map as a PNG image.

2. In the resulting Export Image dialog box, navigate to the flag map project 
folder and name the file whatever you like. Make sure to include the .png 
extension. Otherwise GIMP will not know which file format to export to. 

3. Click Export.

GIMP also allow you to add filters to your image. Using filters certainly isn’t 
required, but filters, such as Oilify, Apply Canvas and Old Photo can add a subtle 
artistic flair to your final map. You can find a list of GIMP filters, including examples 
and instructions, here: 

GIMP Filters
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After applying any desired filters, your final product should look something like this:

Figure 38. The completed flag map, in all its glory.  

That’s it, you are done. To complete this project requires a little attention to detail 
and stick-to-itiveness. Once you get the hang of the process, you can apply the same 
tactics to projects that you design yourself. A map doesn’t have to be boring. 
Hopefully after completing this flag map , even the biggest geographobe will develop 
a new sense of appreciation for maps and how multifaceted they can be. 

28


